# Contents

## What’s New in SMB Version 4.0? ........................................ 4
  Unified Communications ............................................. 4
  General Features ...................................................... 4
  Switchboard Features ............................................... 5

## Getting Started .......................................................... 7
  About the User Suite .................................................. 7
    Logging Into the User Suite ....................................... 7
    Getting Help ......................................................... 7
    User Suite Navigation ............................................. 8

## Settings ............................................................................ 9
  Modify Account ............................................................. 9
  Call Rules ....................................................................... 10
    Call Rule Sets .......................................................... 10
      Call Rules .............................................................. 10
      Creating a New Call Rule Set ..................................... 12
      Managing Call Rule Sets .......................................... 12
    Call Blocking ............................................................ 13
    Messages/Prompts ...................................................... 13
    Time Frames .............................................................. 14
      Creating a New Time Frame ........................................ 14
      Editing a Time Frame .............................................. 15
      Deleting a Time Frame ............................................ 16
  Phonebooks ..................................................................... 16
    Adding Phonebook Entries .......................................... 16
      System Extension Entries ........................................ 16
      External Number Entries ........................................ 18
      Status Indicator Entries ......................................... 18
    Managing Phonebooks ............................................... 18
      Additional Numbers ............................................... 19
  My Profile ....................................................................... 19
  Conference Setup .......................................................... 20
  General Settings ........................................................... 20
  Admin Settings ............................................................ 22

## Voicemail / Fax ............................................................... 23
  Mailbox ........................................................................... 23
  Voicemail ....................................................................... 23
  Faxes ............................................................................. 24
  Putting the Mailbox on Your Desktop .................................. 25
    Sample IMAP Setup .................................................... 25
    Subscribing to Folders ............................................... 28
What’s New in SMB Version 4.0?

Welcome to Switchvox SMB version 4.0! The following sections describe the new features in version 4.0, and provide links to more information about how to use those features.

If you are using the Free version of Switchvox, or Switchvox SOHO, you will not be able to automatically update your software to version 4.0.

Unified Communications

Switchvox SMB 4.0 integrates your phone system with additional communication tools.

Fax

Send and receive faxes using Switchvox! You can use your fax machine, or fax files from your desktop computer. For more information, see the following:

- Fax Options
  To set up fax notification email addresses and a fax header. You can also set the extension to treat all outgoing calls as faxes.
- Setting up a Fax Printer and Creating & Sending a Fax
  For information on using your desktop computer for faxing.

Chat

The new Switchvox private chat server uses the XMPP protocol. The Switchboard offers a Chat Panel, or you can use your favorite XMPP-based client.

Video calling

You can now use video phones with Switchvox. See About Video Calling.

IMAP Mailbox

Each phone-type extension now has a one-stop IMAP Mailbox for voicemail and faxes. See Putting the Mailbox on Your Desktop.

General Features

The new user features add flexibility, and offer great tools for organization.

Voicemail Greetings

You can customize multiple voicemail greetings, specify which greeting should be active, and assign different greetings to play when you are unavailable versus on the phone. See Voicemail Options.
Organized Phonebooks
You can create and manage multiple phonebooks, to keep your contacts organized. You can also see each contact’s ‘Additional Numbers’ that they publish, and create and modify your own additional numbers for them. See Phonebooks.

Additional Numbers
You can set up your own ‘Additional Numbers’ so that co-workers can easily call you at the numbers you publish (your mobile phone, or an extension on the manufacturing floor). See My Profile.

Call queue improvements
You can log into, out of, and pause your status on each queue. When you pause your status, you can add a comment to let people know when you might be back. See Queue Panels.

Conference Announcement
A caller can record his name before entering a conference room. Then, when he enters and exits the conference room, the recording is played. See Conference Setup.

Switchboard Features
The new Switchboard features give you some great organizational options, and more one-click options to Switchvox features. See The Switchboard.

Chat Panel
The chat panel includes the company directory for easy communications.

Company Directory Panel
The Company Directory panel offers type-to-find, to help you quickly find your co-workers’ extensions.

Multiple Phonebook Panels
Each of the your Phonebooks is available as a Switchboard panel.

Centralized presence
Across peered Switchvoxes, Phonebook entries show consistent Presence and call details.

Presence Settings
Presence settings include:
• Available
• Away (includes a comment)
• Chatty
• Extended Away (includes a comment)
• Do Not Disturb
One-click options

These features are now available with quick one-click access in your Switchboard panels:

• Phonebook entries let you dial additional phone numbers.
• Extended entries let you *Barge* and *Whisper* into a call.
• In/out/pause queue-status icons let you set your status for each queue (including a comment for a paused status)
Getting Started

Welcome to Switchvox, the world’s most powerful, yet easy to configure IP-PBX. This document describes how to use the Web-based Switchvox User Tool Suite.

Throughout this document, we refer to the User Suite menu options as a path, using ‘>’. Instead of saying “select the Modify Account option from the Settings menu in the navigation bar, we say “select Settings > Modify Account.”

IMPORTANT: You may find some features described in this document that are not available to you. This is determined by the version of Switchvox you are using, and what features your Switchvox administrator has given you permission to use. Please contact your administrator if you have any questions.

About the User Suite

Each user has a Switchvox account that is his or her phone extension, and a password for that account. Ask your Switchvox administrator for your extension number and password, and for the URL of your Switchvox User Tool Suite (the User Suite).

Logging Into the User Suite

On a computer that is on the same network as Switchvox, open a Web browser and enter the URL of the User Suite:

https://YourServerIPaddress/main

The Login page is displayed. Enter your extension and password (provided by your administrator). Once you are logged in, you may have to change your password. If you do, the strength of your new password is indicated, to help you create a good password. The next time you go to the User Suite, log in using your new password.

To log out of the User Suite, click Logout (located in the upper right-hand corner).

Getting Help

Click any help link to open a pop-up window with information about a particular tool. Help links are available as question-mark icons and as text links.

If a pop-up window does not display, set your Web browser to allow pop-ups from the domain of your Switchvox server.
The User Suite navigation bar contains the following dropdown menus:

**Settings**
Set up your account, specify how you want to handle calls, manage your Phonebooks, and set up your own conference room.

**Voicemail / Fax**
Manage incoming and outgoing voicemail and faxes, set up voicemail greetings, and customize email notifications for voicemail.

**Call History**
See logs of all calls to and from your extension and run usage reports.
The Settings area is where you set up your account, specify how you want to handle calls, manage your Phonebooks, and set up your own conference room.

Modify Account

This section lists basic information about your account: first and last name, email address, and password. Your administrator may have given you permission to change this information. If you do make changes, click Modify Extension to save your changes. A message is displayed to indicate that your changes were successfully saved.

If you are changing your password, the strength of your new password is indicated as you type, to help you create a good password. The next time you go to the User Suite, log in using your new password.

<table>
<thead>
<tr>
<th>Modify Account</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First Name</strong></td>
<td>Justine</td>
<td></td>
</tr>
<tr>
<td><strong>Last Name</strong></td>
<td>Kilean</td>
<td></td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td><a href="mailto:justine@mybiz.com">justine@mybiz.com</a></td>
<td></td>
</tr>
<tr>
<td>Voicemail may be sent here</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>*****</td>
<td></td>
</tr>
<tr>
<td>To retrieve voicemail</td>
<td>Leave blank to keep current password.</td>
<td></td>
</tr>
<tr>
<td><strong>Retype Password</strong></td>
<td>*****</td>
<td></td>
</tr>
<tr>
<td>Leave blank to keep current password.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modify Extension</td>
<td></td>
</tr>
</tbody>
</table>
Call Rules

Call Rules control how your calls are handled. Here are some examples:

- When I’m on the phone, go straight to voicemail
- If I don’t answer, ‘cascade’ calls to my mobile phone then my home phone
- Forward all my calls to another extension
- On weekends and evenings, forward all my calls to another extension
- Hang up on calls from a certain phone number

Call Rule Sets

Unanswered Call Rule Sets specify how a call is handled after a certain number of rings. Busy Call Rule Sets specify how a call is handled when your line is busy. You can set up different rules for those situations, or use the same rules.

When a call is unanswered or your line is busy, Switchvox evaluates each of your Call Rules in the order listed. The first set is evaluated in order, then the second set, and so on. That means that the ‘During Business Hours’ rule that forwards a call to your mobile phone must come before the ‘Anytime’ rule that sends a call straight to your voicemail.

It’s a good idea to test your rules by calling your extension from another phone.

Call Rules

Call-Rule types include the following:

Send to Voicemail
This rule sends a call to your voicemail so the caller can leave a message.

Call Forward
This rule forwards a call to another Switchvox extension. The extension can be another phone, a call queue, or any other type of extension. Once a call is forwarded to the extension, the call rules for that extension are followed.

Call Cascade
This rule rings another extension or an external phone number (i.e., your mobile phone), and if the call isn’t answered then it is passed on to the next rule in the set. This action depends on your Outgoing Call Provider, but if your provider supports it, you can stack several rules that try and reach you at several phone numbers.

Note: If you are cascading a call to an external phone number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.

Secret Code
This rule prompts the caller to enter a secret code, then passes the caller to the next rule in the set. If the caller cannot enter the correct secret code after the specified number of tries, then you can specify what to do with the call.

Ring All
This rule simultaneously rings up to 3 extensions or external phone numbers. Note: If you are ringing an external phone number, be sure to add a ‘9’ or other necessary digits that you normally use to dial out.
Switchvox The User Suite: Settings

### Call Rules

#### Unanswered Call Rule Sets

**Add New Rule Set**

- **Name:** Forward to my mobile  
  **Time Frame:** Outside Business Hours

  1. **Cascade** direct calls to 916195551234 immediately and attempt to preserve caller id.
  2. Send direct calls to **voicemail** after 4 rings.

#### Busy Call Rule Sets

**Add New Busy Rule Set**

- **OR**-

  - **Use my unanswered call rule sets**

  You currently do not have any rule sets defined in this section.

### Call Blocking

**Add Call Block Rule**

- **Move Unanswered Call Rule Sets**

  1. Block **Phone Number:** 918565551234  
     And Then  
     - **Send to Voicemail:**

     when time is **Always**

### Messages/Prompts

- **Secret Code:** “Please enter your password followed by the pound key.”

- **Secret Code:** “Password incorrect. Please enter your password followed by the pound key.”
Creating a New Call Rule Set

To create a new Call Rule Set under Unanswered or Busy, click the appropriate New Rule Set button. To create a new Busy Call Rule Set, you must first un-check the box Use my unanswered call rule sets. That makes the Add New Busy Rule Set button active (it turns blue), so you can click it and create a new rule set.

The settings are as follows:

**Rule Set Name**
- Enter a unique name for this rule set.

**Rule Set Time Frame**
- Select a time frame from the dropdown. Switchvox evaluates the current date and time against this time frame, and if they match then the rule is followed. If they do not match, Switchvox moves on to the next rule. See Time Frames for more information.

Click on Save Ruleset Settings to create the new rule set and add its rules.

1. Select the type of rule to add from the dropdown
2. Click Add Rule.
3. Specify whether the rule applies to direct calls, queue calls, or all calls.
4. Depending on the type of rule you are adding, enter the appropriate extensions or phone numbers.
5. If you are adding a Secret Code rule, enter 1 to 10 digits.
6. If you are creating an Unanswered rule, specify the number of time to ring your phone before following this rule.

Managing Call Rule Sets

If you have multiple Rule Sets, you can drag and drop them to prioritize them appropriately, or you can delete them and replace them with new rules. Your rules need to be put in order because they are executed from top to bottom.

You can have different rule sets for different times, and activate or deactivate them as you see fit. In order to activate a rule set, click on the Activate button to the right of the rule, and fill in the time you want the rule to occur. The active rule set will be highlighted yellow and will display how long it will be active on the right side. This process is the same for Unanswered or Busy Call Rule Sets.
### Switchvox: The User Suite - Settings

#### Call Blocking

Switchvox lets you specify phone numbers that you do not want to accept calls from. You can block specific phone numbers, or any numbers that begin with the same prefix, and you can block them at all times or during specified time frames. You can also choose how Switchvox handles the blocked calls.

Click **Add Call Block Rule** and a new blank rule section appears. Select **Phone Number** or **Prefix** from the dropdown, then enter the number. Be careful entering a prefix; if you put in the wrong prefix you might end up blocking more calls than you expected. Select the action Switchvox should take with the blocked call, then select a Time Frame if you want to control when these calls are blocked. Click **Save** to save your changes to the Call Block Rule.

#### Messages/Prompts

If you use the **Secret Code** feature in a Call Rule, the default sound prompts are provided here. You can change the prompts by recording your own sound over your phone, or uploading a new sound file.

To add or change your own sound, click the prompt’s **New** button. To play the sound, click the prompt’s **Play** button. To remove a sound that you created, and go back to the default sound, click the prompt’s **Use Default** button.

---

**Rule Set Rules**

<table>
<thead>
<tr>
<th>Send To Voicemail</th>
<th>Add Rule</th>
</tr>
</thead>
</table>

**# Move Call Rules**

1. **Cascade**
   - **direct calls**
   - **to** 916195551234
   - **after** Immediately
   - **Attempt to preserve caller id.**

2. **Send**
   - **direct calls**
   - **to voicemail**
   - **after** 4 rings

**Rule Set Settings**

<table>
<thead>
<tr>
<th>Rule Set Name</th>
<th>Forward to my mobile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example: On Vacation</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Rule Set Time Frame</th>
<th>Outside Business Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>When is this rule set used?</td>
<td></td>
</tr>
</tbody>
</table>

**Modify Ruleset Settings**
Switchvox can operate differently based on the date, day, and time. You can set up your Call Rules to check for a Time Frame, and then act accordingly. Your Switchvox administrator maintains a set of default time frames that you can use, or you can create, edit, and delete your own time frames.

A time frame is considered valid when the current date and time match any one of a time frame’s rules. Not all of the rules have to match.

### Creating a New Time Frame

To create a new time frame, enter a unique name and click **Create New**. Enter any appropriate Start and End Dates, Start and End Days, and Start and End times, then click **Add**. Continue adding rules until you have completed the Time Frame definition.

The following are some sample time frame definitions:

**Mondays 12:01AM to 12:00PM, and Wednesdays 12:01AM to 12:00PM**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>Monday</td>
<td>Monday</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>Wednesday</td>
<td>Wednesday</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
**Early Morning**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>3:00 AM</td>
<td>6:00 AM</td>
</tr>
</tbody>
</table>

**The First Week in July 2009**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/01/2009</td>
<td>07/07/2009</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**After January 21, 2009**

**Table 1:**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/21/2009</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Weekdays in February, 2009 between 6:00 and 7:00 in the morning**

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Start Day</th>
<th>End Day</th>
<th>Start Time</th>
<th>End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/01/2009</td>
<td>02/28/2009</td>
<td>Monday</td>
<td>Friday</td>
<td>6:00 AM</td>
<td>7:00 AM</td>
</tr>
</tbody>
</table>

**Editing a Time Frame**

To change one of your own time frames, click its **Edit** button. This displays the Manage This Time Frame page. Create a new rule, or multiple rules, and delete any rules that you do not want to include in this time frame. (You cannot edit a rule.)
Deleting a Time Frame
To delete one of your own time frames, click its **Delete** button. Be sure that you do indeed want to delete this time frame, then click **Yes, Delete Time Frame**. The Time Frames main page is deleted with a message that the time frame was deleted.

Before you delete a Time Frame, be sure you do not have any Call Rules that depend on it.

Phonebooks
Your Switchvox Phonebooks let you organize your contacts so that you can easily access them from your Switchboard. Phonebooks can include your fellow Switchvox users, and external contacts.

Adding Phonebook Entries
There are three types of Phonebook entries:

**System Extension**
Other extensions on your Switchvox PBX.

**External Number**
Phone numbers outside of your Switchvox PBX. Make sure to enter these as you would dial them from your phone. For example, if you must dial 9 to get an external line, this entry must begin with a 9.

**Status Indicator**
These entries are only available for Polycom and snom phones that Switchvox has configured in the Phone Setup tool. If you don’t see this type of entry, check with your Switchvox administrator. A Status Indicator entry controls a line status indicator light on your phone.

This feature is only available in Switchvox SMB.

System Extension Entries

**Phonebook**
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

This feature is only available in Switchvox SMB. Other versions of Switchvox have just one Phonebook.

**Extension(s)**
Enter at least one extension here. To enter multiple extensions, put a comma (,) after each extension. Click the people icon to see a directory of your Switchvox extensions. Hold down Ctrl to select many extensions, or hold down Shift to select a block of extensions.

**Permission Type**

Normal: Shows the user’s Presence, and whether or not he or she is on the phone. Also includes a dropdown that lets you open a chat, call additional numbers, or Intercom the person.

Extended: Shows the Normal features, plus the caller ID name and number of the user’s active calls. It also includes options to monitor, record, whisper, barge into, or pick up the user’s calls.
Only phone-type extensions can be Extended Permission entries. If you try to add any other type of extension (e.g., a Call Queue), it is added as a Normal entry.

You can change an entry’s permission type at any time.

If you cannot see or use an option in an Extended Entry, your Switchvox administrator has not given you permission to do so.
External Number Entries

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

Number
Enter the phone number.

Name
Enter a name.

Jabber ID
Enter this person’s Jabber ID to display his Jabber presence on your Switchboard in his Phonebook entry.

Status Indicator Entries

Phonebook
Select the Phonebook this entry belongs in. To create a new Phonebook, use the New Phonebook tab.

IMPORTANT: This must be the same Phonebook as the one in the Phone Provisioning Options for this entry to affect your phone (see Managing Phonebooks). Also, it must be one of the first entries in the Phonebook if you want it to display without having to scroll through the entries on your phone.

Entry Name
Enter a name for this entry. This isn’t required, as you don’t see the entry in your Switchboard.

Monitor Type
Parking Lot: This lights up the line status indicator on your phone when a caller is waiting in the specified Parking Lot Extension.

Queue Login Status: This lights up the line status indicator on your phone when you are logged into the specified queue. Enter the Agent Login Extension that you use to log into this queue, and the queue that you want to monitor.

Managing Phonebooks

To create a new Phonebook, click the New Phonebook tab. Enter a unique name for this Phonebook, and click Create New Phonebook. This Phonebook is created and is now available in the Phonebook dropdown when you create a new entry.

This feature is only available in Switchvox SMB.

To move an entry back and forth as a Normal or Extended entry, drag the entry’s green arrow icon.

To delete an entry, click its Delete button. Be sure that you do indeed want to delete this entry, then click Yes, Delete. The Phonebook is refreshed, and this entry is gone.

To delete a Phonebook, click its X icon. Be sure that you do indeed want to delete the Phonebook, then click Yes, Delete.

The Phone Provisioning Options let you specify a Phonebook to push out to your phone. If you have a Polycom or a snom phone that Switchvox manages with the Phone Setup tool, you can use this option. When you make changes to a Phonebook, or you want to change the Phonebook that is already on your phone, click Reboot.
Phone to send the correct Phonebook out to your phone. Rebooting your phone takes a few minutes, and you will not be able to make or receive calls while it is rebooting.

Note: If the phone is not on the same network as Switchvox, the phone might not be rebooted. In that case, you must reboot the phone manually.

### Additional Numbers

Each Phonebook entry is based on one main extension or phone number, but it can have also have additional numbers associated with it. This way, you can have one Phonebook entry for a person, and have all of their contact numbers included in that entry. The Additional Numbers are available via a dropdown (the blue plus sign) in the Switchboard Phonebook entry.

This feature is only available in Switchvox SMB.

To see and modify Additional Numbers for an entry, click the entry’s Show button.

<table>
<thead>
<tr>
<th>2</th>
<th>104</th>
<th>Gilbert Brown</th>
<th>SIP Extension</th>
<th>Hide</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Move</td>
<td>Icon</td>
<td>Title</td>
<td>Number</td>
</tr>
<tr>
<td>0</td>
<td>Mobile</td>
<td>5552223456</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>Add A Number</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additional Numbers can be entered by an extension owner, or you can enter them in your Phonebook entry.

Additional Numbers entered by an extension owner are available when you add the extension to your Phonebook. These numbers appear as locked and cannot be edited, but you can choose to hide them in the Switchboard.

Additional numbers that you add to your Phonebook entry can be edited and deleted. You can also copy any Additional Numbers (including the owner’s numbers), and then edit or delete the copy.

### My Profile

Your profile includes Additional numbers that are used to help others in your organization find you when you are away from your desk. For example, you can add your mobile phone number, your home phone number, or even another extension that you use frequently. Numbers added here are shown in your co-workers’ Phonebook entries.

This feature is only available in Switchvox SMB.

To create a new number, click Add A Number. You can set an icon, title, and a phone number or extension. The icon and title are displayed in your co-workers’ Phonebook entries. To change the icon for an entry, click the icon.
Switchvox The User Suite: Settings

Click the pencil icon to change a number, or the red X to delete a number. Drag the green arrows to change the order that your numbers are shown in.

---

**Conference Setup**

This section lets you create your own conference room. Ask your Switchvox Administrator for the main conference room extension number. When a caller dials that number, he or she can access your conference room by dialing your conference room number.

This feature is only available in Switchvox SMB.

**General Settings**

You can change the behavior of your conference room using the following options:

**Your Conference Room Number**

Enter a unique 5-digit number for your conference room. This is the number that you give to callers so they can access your conference room. Click the green arrow to have the system pick a random, unused room number for you.

**Play sound when people enter/leave**

Check this box and select a sound to play to all members of the conference room when a new caller enters the room. There are three options for the sound type that is played when a caller enters and exits your conference room:

- **Only Sound**: Only a sound is played, no information about the caller.
- **Sound with Caller Name**: The caller is prompted to record his or her name. The recorded name is then played along with a sound.
- **Sound with Caller Name (user review option)**: This is the same as Sound with Caller Name, but it gives the caller an opportunity to listen to the recorded name, then accept or re-record it before joining the conference room.
Conference Setup

1. General Settings
   ① What is this for?

   Your Conference Room Number: [blank]
   5 digits

   ✅ Play sound when people enter/leave
   Sound type: [Sound with Caller Name (user review option)]

   □ Play Music On Hold when only 1 member is in the conference

   Conference members may press # and be sent to extension [blank]

2. Admin Settings
   ② Tell me more about admins

   All Available Accounts
   103 "John Smith"
   104 "Gilbert Brown"
   105 "Agner Witt"
   106 "Spencer Flemming"
   107 "Newton Degenhard"
   108 "Webster Savage"
   109 "Posey Podolsky"
   110 "Ortiz Schuster"
   111 "Harvey Culver"
   112 "Webb Sanderson"

   Conference Admins
   101 "Justine Kilean"
   102 "Jane Doeson"

   □ Only allow conference admins to talk
   □ Hang up conference when all conference admins leave
   □ Users can not talk until a conference admin is in the conference room

Save Conference Settings
Play Music On Hold when only 1 member is in the conference
Check this box if you want this to be true. This gives feedback to a caller that they are the only one in the room.

Conference members may press # and be sent to extension []
Enter an extension here, so that when member hit the # key, they are transferred to that extension.

Admin Settings
Admins are special members of a conference room who have additional privileges. Use the lists in this section to identify which extensions are treated as admins of your conference room, and set the options for your admins.

Only allow conference admins to talk
Check this box to make all non-admin callers listen-only.

Hang up conference when all conference admins leave
Check this box to ensure that your conference room is closed down after the conference is over.

Users cannot talk until a conference admin is in the conference room
Check this box to keep callers mute until an admin is in the room. Callers can join the room, but they cannot speak to each other.
Voicemail / Fax

This area lets you set up your voicemail and fax options, and manage incoming and outgoing voicemail and faxes.

Mailbox

Your Mailbox lets you manage your voicemail and faxes in Switchvox.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Voicemail / Fax</th>
<th>Call History</th>
</tr>
</thead>
</table>

Mailbox

Organize your voicemail as easily as you organize your email. Put voicemails into folders, forward and delete voicemails from the system.

Voicemail in INBOX (0) of 2

| 101 | Doe, John | Thu Mar 19 2009, 10:10:16 AM |
| 101 | Smith, John | Wed Mar 18 2009, 2:10:16 PM |

You can access your Mailbox here in the User Suite, or from your desktop email application. See Putting the Mailbox on Your Desktop for more information about using your desktop email application. This feature is only available in Switchvox SMB.

Voicemail

Your voicemail comes into the INBOX folder. Each message displays the original mailbox the message was left in (the message might have been forwarded to you by a co-worker), the caller ID of the caller (if it was available), the date and time the message was left, and the duration of the message.

To play or download a message, click its Play button. This marks the message as Read (it is no longer shown as bold, and the message-waiting indicator light on your phone would go off if this was your only unread message).

To delete messages, or mark them as read or unread, check the box for each message that you want to affect. Then, click the appropriate icon (at the top of the list). If you
delete messages, you are prompted to verify the action. Be sure that you do indeed want to delete the messages, then click **Yes, Delete**.

To move messages to a different folder, check the box for each message that you want to move, select the folder where the messages belong, then click **Move To Folder**.

To forward messages to another Switchvox user, check the box for each message that you want to forward, select the extension to forward them to, then click **Forward To**.

To sort by column in the message list, click the column name.

**Note:** You can also manage your voicemail from your phone by dialing the voicemail access extension (default is 899). Follow the prompts to give your password and check your messages. Or, your phone may have a **Messages** button that dials the voicemail access extension for you.

---

### Faxes

Your faxes come into the **Fax** folder. Your outgoing faxes are stored in the folders **Drafts**, **Outbox**, and **Sent**. The **Drafts** folder includes the files that you have printed to your Switchvox fax printer. The **Outbox** folder includes faxes that Switchvox is currently trying to send (or was unable to send). The **Sent** folder includes faxes that Switchvox has successfully sent.

This feature is only available in Switchvox SMB. A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox administrator.

To send a fax, check its box (you can only send one fax at a time) then click the fax machine icon (at the top of the list). You are prompted to enter a fax number. Enter the number for the fax machine you want to send this fax to, then click **Send Fax**.

**IMPORTANT:** When you enter the fax number, be sure to prefix any digits that you normally use to dial out.

Your fax is in the **Outbox** folder while it is being sent, and moved to the **Sent** folder when it has been successfully sent. If Switchvox cannot reach the other fax number to send your fax successfully, it remains in the **Outbox** folder.

**Note:** Switchvox sends fax notification email messages. These notification messages show the status of your fax. A **Pending** fax is still being sent (a fax may be Pending for a little while if Switchvox has to try multiple times), a **Sent** fax has been sent successfully, and a **Failed** fax was never received by the fax machine at the number you indicated. For details on setting up fax notifications, see **Fax Options**.

To preview page 1 of a fax, click **Preview**.

To view or download an entire fax, click **Download**. This marks the fax as **Read** (it is no longer shown as bold).

To delete faxes, or mark them as **read** or **unread**, check the box for each fax that you want to affect. Then, click the appropriate icon (at the top of the list). If you delete faxes, you are prompted to verify the action. Be sure that you do indeed want to delete the faxes, then click **Yes, Delete**.

To move faxes to a different folder, check the box for each fax that you want to move, select the folder where the faxes belong, then click **Move To Folder**.

To forward faxes to another Switchvox user, check the box for each fax that you want to forward, select the extension to forward them to, then click **Forward To**.
Putting the Mailbox on Your Desktop

Your Switchvox Mailbox uses IMAP, a protocol that lets your desktop email application access remote messages as if they were stored on your computer. In this case, it means that you can access your voicemail and faxes in your Switchvox Mailbox using your regular email application (e.g., Microsoft Outlook or Mozilla Thunderbird).

This feature is only available in Switchvox SMB.

Your Switchvox Mailbox does not offer outgoing mail service, so if you want to forward a message or a fax, you need to use your regular email account.

To set up your Switchvox IMAP Mailbox in your desktop email application, you’ll need the following information:

- The IP address or domain name of your Switchvox mail server. This is the same IP or name that you use for the Switchvox User Suite.
- Your ‘email address,’ which in this case is your extension number, the @ sign, then your IP address or domain name. For example: 101@192.168.0.100, or 101@pbx.mybusiness.com.
- Your ‘user name’, which in this case is your extension number.
- Your password, which is the same password that you use to log into the Switchvox User Suite and to collect your voicemail.

**IMPORTANT:** If you are having trouble using your Switchvox IMAP account in your email application, check with your Switchvox administrator. It’s possible that you need to use a different port number than the default (143), or that you need to set specific security options.

In your email application, start the process to create a new Internet email account. When you are prompted to enter the type of incoming mail server for the account, choose IMAP. Enter the rest of the information as prompted.

**Sample IMAP Setup**

The following pages give an example of creating an IMAP account in Microsoft Office Outlook 2007, running on the operating system Windows XP Professional.
1. Open Microsoft Outlook, and select Tools > Account Settings.
   The E-mail Accounts window is displayed.

2. Click New to create a new e-mail account.

3. The Auto Account Setup window is displayed.
4. Check the box for **Manually configure server settings or additional server types**.

5. Click **Next**.

   The *Choose E-mail Service* window is displayed.

6. Select **Internet E-mail**.

7. Click **Next**.
The Internet E-mail Settings window is displayed.

8. Enter your name and your email address in the User Information section.

9. Select the Account Type IMAP, and enter the IP address or domain name of your Switchvox mail server in the Server Information section.

10. Enter your user name and password in the Logon Information section.

   Check the box Remember password if you don’t want to have to enter your password each time you access your email.

11. Click Next.

You’re finished adding this account.

**Subscribing to Folders**

When you have your Switchvox IMAP account set up in your desktop email application, you can manage the same folders that are in the Switchvox User Suite Mailbox (Voicemail / Fax > Mailbox).

You can ‘subscribe’ to all of the folders, or just the ones you want to use. If you ‘unsubscribe’ to a folder, it still exists in your IMAP account, it just isn’t shown in your email application. You can always subscribe to it again later.
You can also create folders using your desktop application, and those folders are accessible in your User Suite Mailbox.

To subscribe to your IMAP folders in Microsoft Outlook, highlight your Switchvox IMAP Inbox and select **Tools > IMAP Folders**. The **IMAP Folders** window is displayed, shown here:

In Mozilla Thunderbird, highlight the account and select **File > Subscribe**. In either case, a list of folders is displayed that lets you subscribe and unsubscribe.

### Voicemail Options

Your Voicemail Options include setting up your voicemail greetings and defining how you want to receive notifications of a new voicemail message.

**Managing Greetings**

Manage Voicemail Greetings lets you set up all of your greetings that might be played to a caller when you don’t answer the phone. You can upload a sound file from your computer, or record a greeting using your phone.

This feature is only available in Switchvox SMB. In Switchvox SOHO and the Free version, you cannot customize multiple voicemail greetings.

The default greeting, in every situation, is for Switchvox to read your extension digits and then let the caller record a voicemail message. You can record or upload your name, and multiple custom messages for when you don’t answer the phone, or you are already on a call and don’t answer the phone. If you don’t want to distinguish
between those situations, make sure you have created an Unavailable Voicemail greeting, then check the box under the “Busy” voicemail greeting, **Use Unavailable voicemail greeting.**

### Manage Voicemail Greetings

**Full name.**
This recording is used in the company directory and by the default Unavailable and Busy greetings.

<table>
<thead>
<tr>
<th>In Use</th>
<th>Greeting Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Read Extension Digits</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Standard</strong></td>
</tr>
</tbody>
</table>

**Unavailable** voicemail greeting.
This recording is played to prompt callers to leave you a voicemail message when you do not answer your phone.

<table>
<thead>
<tr>
<th>In Use</th>
<th>Greeting Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Default Unavailable Message</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Standard</strong></td>
</tr>
</tbody>
</table>

**Busy** voicemail greeting.
This recording is played to prompt callers to leave you a voicemail message when you are already on a call waiting.

- [ ] Use Unavailable voicemail greeting.

<table>
<thead>
<tr>
<th>In Use</th>
<th>Greeting Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Default Busy Message</strong></td>
</tr>
</tbody>
</table>

[Record New Greeting]
Setting Notifications

Voicemail notification options let you customize how you want to receive a notification when you get a voicemail message. You can set up multiple email addresses, each with an email template and instructions for attaching the voicemail as a WAV file.

This feature is only available in Switchvox SMB. In Switchvox SOHO and the Free version, you cannot customize notifications.

Note: Notification email messages do not synchronize with your Switchvox Mailbox. That means that if you listen to a voicemail WAV file attached to a notification message, Switchvox does not know that you have ‘read’ the voicemail.

2 Voicemail Notification Options

Tell me more about this

Add New Notification Email

<table>
<thead>
<tr>
<th>#</th>
<th>Template</th>
<th>Email</th>
<th>Attach WAV File</th>
<th>Modify/Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Default</td>
<td>local copy</td>
<td>Yes</td>
<td>Edit</td>
</tr>
<tr>
<td>2</td>
<td>External</td>
<td><a href="mailto:justine@mybiz.com">justine@mybiz.com</a></td>
<td>Yes</td>
<td>Edit</td>
</tr>
</tbody>
</table>

Delete local copy of voicemail.

To add a new notification option, click Add New Notification Email. Enter your Email address, select a template, and select Yes or No to indicate whether or not to attach the voicemail WAV file to the email message.

To edit a notification option, click its Edit button.

To delete a notification option, click its Delete button. You cannot delete the local copy option (that is the copy in your Switchvox IMAP mailbox), but you can change the template. This is the template that you will see if you subscribe to your Switchvox IMAP mailbox using your desktop email application.

To delete the Switchvox copy of the voicemail once its sent to your email address(es), check the box Delete local copy of voicemail. This option lets you handle your voicemail entirely through your own email account.
Managing Notification Templates

Voicemail Email Templates let you customize your voicemail notification email messages. You can create multiple templates and tailor them to different types of email accounts. These custom templates are available (along with default templates) when you create or edit a Voicemail Notification Option.

You can use variables in your template that are substituted with real values when the email gets sent. For example, %VM_CALLERID% in a template prints as the caller’s name and phone number. There is a full list of these variables on the pages where you create or edit a template.
Modify Voicemail Email Template ('personal')

Below you can the customize the email template that gets sent to the user when they receive a new voicemail message.

Subject: %VM_CALLERID% left you a new %VM_DUR% long message

Dear %VM_NAME%:

You just received a %VM_DUR% long message in mailbox %VM_MAILBOX% from %VM_CALLERID%, on %VM_DATE%.

You can get this message via the phone, or use the links below to download the message.

Download the message and mark it as read.
%DOWNLOAD_LINK%

Note: This will mark it as read in the system.

Download the message and delete it.
Important: This will completely remove the message from the system and this link will no longer work.
%DOWNLOAD_LINK_AND_MARK_DELETED%

Thank you!

--Switchvox

You can use variables in your template that will be substituted with the real values when the email gets sent.

%VM_NAME% - Recipient's firstname and lastname
%VM_DUR% - The duration of the voicemail message
%VM_MAILBOX% - The recipient's extension
%VM_CALLERID% - The caller id of the person who left the message
%VM_DATE% - The date and time the message was left
%DOWNLOAD_LINK% - A URL to the web admin to download the message
%DOWNLOAD_LINK_AND_MARK_DELETED% - A URL to the web admin to download the message from the recipient's mailbox.

Save Template
Automatically Forwarding Voicemail

You can automatically forward all of this extension’s voicemail messages to other extensions in Switchvox. This is helpful for generic extensions such as ‘Accounting,’ or ‘Shipping,’ or for queue extensions such as ‘Customer Service.’ Callers can leave messages on one extension, then all of those messages are forwarded to the appropriate people. This is also useful internally, if you want to send a message to everyone in a group.

This feature is only available in Switchvox SMB.

To define a specific set of extensions to receive the forwarded voicemail, select Individual Extensions, and move the appropriate extensions into the box on the right.

To specify an Extension Group to receive the forwarded voicemail, select Predefined Group, then choose an Extension Group from the dropdown.

To delete each message from this extension’s Mailbox after the message is forwarded, check the box Delete on Forward.

To send forwarded messages to all of the recipients, choose Send to All from the Forwarding Type dropdown. To send forwarded messages to one recipient at a time, choose Round Robin. With Round Robin, Switchvox forwards each message to the next recipient, moving through the list of recipients in the same order as they are listed (in the extensions box above, or in the Extension Group).
Fax Options

Fax Options let you set up multiple email addresses to be notified when you have received a fax. This is useful if you want to be notified at both your work and personal email addresses, or if you want your administrative assistant to be notified.

You can also enter a Fax Header to be sent with each fax that you send. For example:

```
Digium, Inc. | 877.546.8963 | Fax: 858.555.1212
```

This is the information that is printed along the very top of your fax pages (not to be confused with a cover page).

If this extension is really a fax machine and won’t make any voice calls, check the box This extension only sends faxes.

This feature is only available in Switchvox SMB. A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox administrator.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Voicemail / Fax</th>
<th>Call History</th>
</tr>
</thead>
</table>

Fax Options

1. Fax Notification Options

<table>
<thead>
<tr>
<th>Add New Notification Email</th>
</tr>
</thead>
<tbody>
<tr>
<td># Email Modify/Delete</td>
</tr>
<tr>
<td>1 <a href="mailto:justine@mybiz.com">justine@mybiz.com</a> Edit Delete</td>
</tr>
</tbody>
</table>

2. Receiving / Sending Options

- This extension only sends faxes.
- Fax Header: Digium, Inc. - T: 877.546.8963, F: 858.555.1212

Show Advanced Options

Save Fax Options
Advanced Options

It is unusual to change the Advanced Options, so they are hidden. If you find that you need to change an Advanced Option, click **Show Advanced Options**.

**Local Station ID**
Text string that identifies the sender identification to the remote side of the fax transmission. Default is to leave blank.

**Disable Error Correction Mode (ECM) for G711 fax sessions**
Disable error correction mode (ECM). The default is to leave this feature enabled.

**Minimum transfer rate for fax transmission**
Minimum transfer rate used during fax rate negotiation. The default minimum transfer rate is 2400.

**Maximum transfer rate for fax transmission**
Maximum transfer rate used during fax rate negotiation. The default maximum transfer rate is 14400.

**Number of redundant signal packets for T38 fax sessions**
T38 Error Correction Code (ECC) Signal Redundancy. This option specifies the number of redundant signal packets contained in a T38 signal frame. The default value is 3.

**Number of redundant image packets for T38 fax sessions**
T38 Error Correction Code (ECC) Data Redundancy. This option specifies the number of redundant image packets contained in a T38 image frame. The default value is 1.

**Number of maximum expected T38 packet delay**
Maximum expected T38 packet delay in milliseconds. The result of this specification is all T38 packets are padded to prepare the fax stack for the specified delay. As long as the packet delay is less than or equal to the specified value, the fax stack will not realize that there is an actual packet delay because of the packet padding. The default value of 800 milliseconds should cover most use cases.

Creating & Sending a Fax

Sending a fax from your desktop computer using Switchvox is a two-step process:

1. Open a file in any application and print it to the Switchvox fax printer.
   
   This stores a copy of the file in your Switchvox Mailbox **Fax Drafts** folder.

2. Go to the Switchvox User Suite **Voicemail / Fax > Mailbox**, select the **Fax Drafts** folder, and click the fax machine icon (at the top of the list) to send that file to a fax machine. For details, see **Faxes**.

This feature is only available in Switchvox SMB. A fax license and the fax software must be installed to make faxing available. For details, ask your Switchvox administrator.
Setting up a Fax Printer

To make faxes for Switchvox, you need to first set up a generic printer that you can use from any application. You only have to do this once.

Depending on your desktop environment there are many ways to set up a printer, but there is some specific information that you need to set up a Switchvox Fax Printer:

• For **Windows-based operating systems**, the URL is

  http://YourDomain:631/printers/faxprinter

  Where *YourDomain* is the domain that you normally use to go to your Switchvox User Suite. This may be an IP address or a domain name.

• For **Linux- or Macintosh-based operating systems**, the URL is

  http://ext:password@YourDomain:631/printers/faxprinter

  Where *ext* is your extension, *password* is the password that you use to log into the Switchvox User Suite or to collect your voicemail, and *YourDomain* is the domain that you normally use to go to your Switchvox User Suite. This may be an IP address or a domain name.

• For **any** operating system, use a generic postscript printer driver.

  Our suggestion for Windows-based operating systems is the driver from IBM: *IBM Network Printer 17 PS*. For Linux- and Macintosh-based operating systems you should choose a generic postscript printer driver.

**Sample Printer Setup**

The following pages give an example of setting up a Switchvox fax printer for a computer running a Windows XP Professional operating system.
1. From the **Start** menu, go to **Printers and Faxes**.

   The Printers and Faxes window is displayed.

   ![Printers and Faxes window](image)

   Start the Add Printer Wizard, which helps you install a printer.

   2. Click **Add a Printer**.

   The Add Printer Wizard is displayed.

   ![Add Printer Wizard](image)

   **Welcome to the Add Printer Wizard**

   This wizard helps you install a printer or make printer connections.

   ![Info icon](image)

   If you have a Plug and Play printer that connects through a USE port (or any other hot pluggable port, such as IEEE 1394, infrared, and so on), you do not need to use this wizard. Click **Cancel** to close the wizard, and then plug the printer's cable into your computer or point the printer toward your computer's infrared port, and turn the printer on. Windows will automatically install the printer for you.

   To continue, click **Next**.

   ![Next and Cancel buttons](image)

   3. Click **Next**.
The Local or Network Printer windows is displayed.

4. Select *A Network Printer*...

5. Click **Next**.
The Specify a Printer window is displayed.

6. Select **Connect to a printer on the Internet or on a home or office network**, and enter the following URL:

   http://YourDomain:631/printers/faxprinter

   Where **YourDomain** is the domain that you normally use to go to your Switchvox User Suite. This may be an IP address or a domain name.

7. Click **Next**.
The **Configure Internet Port** window is displayed.

8. Select *Use the specified user account*, and enter your extension number and your password. This is the same password that you use to log into the Switchvox User Suite or to collect your voicemail.

9. Click **OK**.
The manufacturer and model window is displayed.

10. Select IBM from the Manufacturer list on the left, then select IBM Network Printer 17 PS from the Printers list on the right.

We suggest this printer driver because it is a widely available, standard printer driver. If you are using a different operating system, choose a generic postscript printer driver.

The Printer Wizard copies the appropriate files for you and sets up your new printer.

Wait until the Default Printer page is displayed, then go on.

11. Select Yes or No, depending on whether you want this to be your default printer. (You probably want to select No).

The final page of the Printer Wizard is displayed.

12. Click Finish.

In the Printers and Faxes window, you can see the new printer faxprinter on http://YourDomain:631
Sending a Fax

Now that you have your fax printer set up, you can create a fax from any application.

1. Select the Print option from the application that you are using to view this document. (Or any open file that is handy.) In the Print dialog box, select the new ‘faxprinter’ as the printer to use, and print the file.

2. In your Switchvox User Suite, go to Voicemail / Fax > Mailbox. Select Fax:Drafts from the View Folder dropdown.

Your Fax:Drafts folder is opened, and your drafts are listed. The test page that you printed is in the list, and you can preview the first page, or download a PDF of the entire fax.

Check the box for your fax, then click the fax machine icon (at the top of the list). You are prompted to enter a fax number. Enter the number for the fax machine you want to send this fax to, then click Send Fax.

Your fax is in the Outbox folder while it is being sent, and moved to the Sent folder when it has been successfully sent.
Call History

Under the Call History tab are two sections, Call Log and Call Reporting. These allow you to track your phone use.

Call Log

The Call Log is a simple list of the calls that have been made to or by your extension. You can select a date range by setting the From and To dates. Click View Report to see log in the User Suite, or click Output to .xls file to download an xls file.

By default, a list of all incoming and outgoing calls is displayed. The list includes the call date, who the call was from and to, the type of call (incoming or outgoing), the call time, and the talk time. If you are viewing the log in the User Suite, you can mouse over the Call Details to see more details about the call.

<table>
<thead>
<tr>
<th>Call Date</th>
<th>Call From</th>
<th>Call To</th>
<th>Call Type</th>
<th>Call Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/18/09 3:28:19 PM</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>Gilbert Brown &lt;104&gt;</td>
<td>outgoing</td>
<td>39s</td>
</tr>
<tr>
<td>03/18/09 3:22:30 PM</td>
<td>John Smith &lt;103&gt;</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>outgoing</td>
<td>4s</td>
</tr>
<tr>
<td>03/18/09 2:10:15 PM</td>
<td>John Smith &lt;103&gt;</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>outgoing</td>
<td>53s</td>
</tr>
<tr>
<td>03/18/09 2:09:05 PM</td>
<td>John Smith &lt;103&gt;</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>outgoing</td>
<td>1m, 0s</td>
</tr>
<tr>
<td>03/18/09 2:08:00 PM</td>
<td>John Smith &lt;103&gt;</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>outgoing</td>
<td>14s</td>
</tr>
<tr>
<td>03/18/09 1:18:25 PM</td>
<td>Jane Doeson &lt;102&gt;</td>
<td>Justine Kilean &lt;101&gt;</td>
<td>outgoing</td>
<td>10s</td>
</tr>
</tbody>
</table>
Call Reporting

This lets you generate a report about call activity. Call reports are generated for the date-range and criteria that you specify, and include the information that you specify.

In the Report fields section you select one or more of the fields you would like included in the report or graph. After you have chosen the desired fields you can choose how you want the report broken down. By default the reports are broken down by date such that a data point is displayed for each day between the From and To date.

You can instead opt to have the report broken down by the Hour of Day, the Day of Week or just one data point for the whole range by selecting Total Cumulative. When you have finished specifying your criteria, you can opt to have the report printed to the screen, sent to your desktop as an .xls file or view it in graphical form in a chart.

Call Reporting

Use this form to generate custom statistical reports about this extension’s call history.

From Date: 03/17/2009  To Date: 03/18/2009

Report Breakdown:
- Total Cumulative
- Total Cumulative

Report Fields:
- Total Number of Calls
- Total Number of Incoming Calls
- Total Number of Outgoing Calls
- Total Talking Time
- Total Call Duration
- Average Talk Time per Call
- Average Call Time per Call

Hold down CTRL to select multiple items

View Report  Output to .xls file  Chart Report

Digium, Inc.
The Switchboard

The Switchboard is a graphical display of what’s happening on Switchvox. It shows your own calls, your coworkers’ calls, call-queue activity, and your parking lot. You can drag and drop to transfer calls, and one click lets you make a call, pick up calls, record or monitor calls, log in and out of call queues, and more.

In addition to all of the Switchvox interaction, the Switchboard is also ‘Web Aware,’ which means that you can integrate other web applications with your call activity. Built-in panels bring SugarCRM, Salesforce, and Google Maps to the Switchboard, and you can build custom panels that use the URL of your choice.

This feature is only available in Switchvox SMB.

To open your Switchboard, click Launch Switchboard (in the upper right corner of your User Suite).

In the upper right of the Switchboard, you can see the number of voicemail messages that you have, new and old. There is also an Options menu that lets you control your Switchboard.

Your Switchboard lets you have up to 6 active lines on your extension (in the Current Calls panel), regardless of your phone’s capabilities.

About the Options Menu

The Options menu lets you control your Switchboard.

Save Layout

Save Layout lets you save your Switchboard layout. The next time you open the Switchboard, the window is the same size, and the same panels are open in the same place.
Panels

Panels let you open and close all of your Switchboard panels. Each of your Phonebooks is available as a separate panel.

Your Switchvox administrator must give you permission to use many of the features available in the Switchboard Panels. If you see a feature described here that is not available to you, please ask your administrator.

My Presence

My Presence lets you set your Switchboard presence so that your co-workers can see your status and decide how to communicate with you.

The Away and Extended Away options let you include a comment so that you can let people know when you might be back.

Panels

The Switchboard panels let you see into the activity on Switchvox and manage your calls.

Current Calls Panel

The Current Calls panel displays all of the active calls on your extension, and gives you many options for handling those calls. You can have as many as six current calls in the Switchboard, even if your handset does not support that many.

Send Call
If you choose not to answer a call, click Send to send the call to your Call Rules. The default rule is to send your calls to voicemail, so most likely Send means the caller is sent to your voicemail.

Hold & Resume
When you are on a call, one click puts that call on Hold, or Resumes the call.

Note: Resume is not available until you put the call on Hold.

Take Another Call
You can put your active call on Hold, and then answer another incoming call. You can have as many as six current calls in the Switchboard, even if your handset does not support that many.

Transfer: Assisted & Blind
To transfer a call to someone in your Phonebook, just click the call and drag it from Current Calls to the Phonebook entry. You can transfer a call at any time, even if you have the call on hold, or the other extension is on an active call.

In an assisted transfer, you would put the caller on hold, call your co-worker to let him know you’d like to transfer a caller, then complete the transfer. In a blind transfer, you would just drag the call to the Phonebook entry.

Transfer to Voicemail
To transfer a call to your coworker’s voicemail, just click the call and drag it from Current Calls to the Phonebook entry’s envelope icon. This is handy if you know your co-worker isn’t able to take the call.

Record
When you are on a call, you can click to start and stop a recording of your call. The recording is sent to your voicemail Mailbox, where you can save or forward it. Don’t forget, it’s up to you to let the other party know that you’re recording the call.
Directory Panel

The Directory panel offers you access to all of the extensions in Switchvox. You can click and drag a call to an entry in the Directory Panel to transfer the call to that extension.

Parking Lot Panel

The Parking Lot panel lets you ‘Park’ a call so that the call can be picked up at a different extension. To Park a call, just click and drag the call to the Parking Lot panel. Then, you or any of your coworkers can pick up a phone and dial the Parking Lot extension to be connected to the caller.

An extension must have permission to pick up a parked call.

Phonebook Panels

Each Phonebook panel displays the entries in that Phonebook. You can click on any entry to dial that number. Some extensions can display as Extended Entries, to help you communicate more effectively with that person.

Normal Entries

Normal Phonebook entries show your coworkers’ extensions or your frequently dialed external phone numbers. Each extension is shown with its Presence information, and you can click on any of these to dial them, like a speed dial button.
Also, Normal entries provide a ‘plus’ icon that includes options to dial that person’s Additional Numbers, chat with him, or Intercom to him.

You must have permission to use Chat and Intercom. Chat may not be available if for some reason you can’t chat with that person.

**Extended Entries**

Extended Phonebook entries have all of the normal extension options, but they also let you do the following with that extension’s calls:

- Pick up an incoming call
- See who the caller is
- Record the call
- Monitor the call (the callers do not hear you)
- Barge into the call (both callers hear you)
- Whisper on the call (only your co-worker hears you)

You must have permission to use each of these options.

**Presence**

All Phonebook entries display the person’s **Presence**, which helps you and your coworkers be selective about what calls to transfer to each other. An *Away* or *Extended Away* Presence can include comments.

**Intercom**

All Phonebook entries can include the **Intercom** option, which lets you talk to a coworker through the speaker on his phone. With Intercom, your recipient doesn’t even need to pick up the handset to answer your call.

You must have permission to use this.

**Pickup**

Extended Phonebook entries can include the **Pickup** option (the green ‘up’ arrow). One click and your coworker’s incoming call rings your extension also.

You must have permission to use this.

**Record**

Extended Phonebook entries can include the **Record** option. One click records the call, and sends the recording to your voicemail Mailbox.

You must have permission to use this.

**Monitor**

Extended Phonebook entries can include the **Monitor** option. If you monitor a call, the callers cannot hear you.

You must have permission to use this.

**Barge**

Extended Phonebook entries can include the **Barge** option. If you barge into a call, both of the callers can hear you.

You must have permission to use this.

**Whisper**

Extended Phonebook entries can include the **Whisper** option. If you whisper into a call, the caller cannot hear only (only the extension owner can hear you).

You must have permission to use this.
Chat Panel

The Chat panel lets you chat with your Switchvox co-workers. The main page of the Chat Panel offers a list of people you can double-click to start a chat. Or, enter a Jabber ID and click **Start Chat**.

You must have permission to use this.

Queue Panels

Each Call Queue panel in your Switchboard contains views into that queue’s activity and statistics for the day.

For queue members, you can log into or out of each queue with one click. Or, you can pause your status and add a comment, letting your co-workers know why you’re unavailable and when you’ll be back.

You must have permission to use this.

CRM Panels

These time-saving panels integrate with your CRM application. When a call rings your phone, all of the information for this customer is displayed immediately, before you even answer the phone!

You must have permission to use this.

Google Maps Panel

The Google Maps panel shows you where your caller is on a map based on area code and prefix. A popup window lets you scroll through previous callers’ locations.

You must have permission to use this.

Custom Panels

Your Switchvox administrator may have set up custom panels that integrate with Web applications. Ask your administrator for more information.
Popup URLs

Your Switchvox administrator can write external applications that set a display URL for each incoming call. If this value is set, then the URL button lights up and clicking it opens a new window with the specified URL. If you want that window to automatically open when a call comes in, click the green plus sign at the top-right of the panel.